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1
Getting Started with Foglight

The Quest Foglight User Guide helps you monitor your enterprise from a variety of perspectives using the Alarms,
Domains, My Services, and Hosts dashboards. It presents workflows for drilling down and investigating problems
in your monitored environment using these dashboards.

This guide also introduces you to navigating the Foglight browser interface and using reports to share data from
Foglight with others in your organization.

This guide is intended for users who have been assigned the Operator or Advanced Operator role and who need
to perform tasks such as monitoring their environment, working with alarms, and creating reports.

; | NOTE: This guide uses terminology that is specific to the Foglight browser interface. For more
information about these terms, see the Foglight User Help (navigate to Help > Help Contents > Using
Foglight > User Help > Getting Started with Foglight > Working with Dashboards in the action panel and
then click Working with Dashboards).

Getting Started

This chapter provides instructions for logging in to Foglight and describes the Welcome page you see when you

log in with the Operator or Advanced Operator role. It also introduces you to navigating the Foglight browser
interface and discusses best practices for navigation.

; | NOTE: Your Administrator may have configured Foglight so that the actual displays are different from
those described in this chapter. The following information is intended as a general guide.

Perform these steps before following the instructions in this chapter:
* Obtain your Foglight user name and password from your Administrator.
¢ Ensure that your Web browser has JavaScript functionality enabled.

e Ensure that your account has the Console User role. This is required to view the new Foglight interface
components.

Logging in to Foglight
This topic describes how to log in to the Foglight browser interface.
To log in to Foglight:

1 Open a Web browser instance.

; | NOTE: For a list of browsers supported by Foglight, see the System Requirements and
Platform Support Guide.

2 Navigate to a URL that uses the following syntax:

http://localhost:8080/
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where localhost is the name of the machine that has a running instance of the Management Server.
The Foglight login page appears.
3 Enter your user name and password in the login page.

This guide assumes that you are a user with the Operator or Advanced Operator role, in which case the
Welcome to Foglight page is the first dashboard you see when you log in to Foglight.

; | NOTE: The appearance of the Welcome page and the range of dashboards you can access from
this page vary depending on your user role. If you have Administrator-level permissions, you can
access advanced dashboards and configuration workflows. See the Administration and
Configuration Guide. Users with the Operator role (but not the Administrator role) have permission to
access a smaller set of dashboards.

If you are a user who has a role or a role combination assigned to you that does not provide
sufficient privileges to do anything useful in Foglight, a warning page is displayed. Contact your
Foglight Security Administrator to get additional roles assigned to your account or to request that a
different home page be configured for you.

Starting from the Welcome Page

Foglight Users:
An Operator’s welcome page lists the following commonly-performed tasks:

* View Your Enterprise Health: Choose one of Foglight's pre-defined views to summarize the overall health
of your IT infrastructure.

= View, Acknowledge, and Clear Recent Alarms: View the state of all alarms across the entire
Foglight installation in the Alarms dashboard so you can take immediate action on them. The
Alarms dashboard shows alarm counts by time, allowing you to identify excessive alarm counts or
outage events. This link takes you to the Alarms dashboard. Another way to access this dashboard
is by choosing Alarms under Homes on the navigation panel. See Viewing, Acknowledging, and
Clearing Alarms on page 49.

= View Enterprise Health Organized by Monitoring Domain: View an end-to-end, top-level
summary of all domains in the Domains dashboard and drill down to view their managed instances.
This link takes you to the Domains dashboard. Another way to access this dashboard is by
choosing Domains under Dashboards on the navigation panel. See Monitoring Your Domains on
page 64.

= View the Health of Critical Services: Choose a level of service as a focal point by subscribing to
services of interest and viewing their dependencies. This link takes you to the My Services. Another
way to access this dashboard is by choosing My Services under Dashboards on the navigation
panel. For more information, see Monitoring Your Services on page 67.

= View the Health of the Monitored Hosts in Your Enterprise: View alarms and a high-level
summary of performance on your monitored hosts. This link takes you to the Hosts dashboard. For
more information, see Monitoring Your Hosts on page 71.

* Configure Alarm Reporting and Blackouts: Configure the mail server and assign email routing for
Foglight alarm notifications. Configure blackout period to suspend monitoring activities.

= Configure Email Settings: Configure the mail server and assign email routing for Foglight alarm
notifications.

= Blackout Configuration: Configure blackout period to suspend monitoring activities.

* Report on Your Enterprise: View reports that are scheduled, run a report using a report template, create
a custom report, schedule a report to run at a specific time, and manage reports. This link takes you to the
Reports dashboard. Another way to access this dashboard is by choosing Reports under Homes on the
navigation panel. For more information on reports, see Reporting on Your Enterprise on page 75.
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= Build a Custom Report: Build a report template from components or specify parameters to
produce reports.

= Run a Report: Generate a one-time report based on a template and schedule a report to run at a
specific time.

= Manage Reports: Manage the schedule reports and generated reports.

* Do More with Foglight: Create custom services, build new dashboards and access other administrative
functions in Foglight.

= Administer Foglight: Manage users, define data retention policies, install or remove functionality,
and manage licensing.

= Build a Dashboard: Use the Foglight dashboard editor to create your own view onto your
enterprise infrastructure.

= Define Services: Create and edit services to organize your monitoring data along business lines.
Create custom SLA policies which track the health of your infrastructure from a service perspective.

= View Agent Status: View the status of the agents which are monitoring your enterprise, configure
existing agents, or create new agents to monitor more of your infrastructure.

= Contact Supportlink: Get help and technical support through Quest Software's official support
website.

= Explore Foglight Documentation: View the on-line help and detailed documentation to learn more
about Foglight.

* Tap into the Foglight Community: Takes you to the foglight.org Web site, which discusses topics related
to Application Management and Foglight.

The Welcome to Foglight page is your default home page. For instructions on changing your home page to a
dashboard of your choice, see Choosing a Home Page.

Foglight Evolve Users:

When you log in to Foglight Evolve for the first time, the Getting Started tab of the Environment Overview page
appears in the display area.

i | NOTE: The General Access role is required to see the Foglight Welcome page.

This tab displays tiles based on the products that are installed.
From this tab, you can quickly perform a number of activities:
¢ Explore Hyper-V—access the Hyper-V Environment Overview page.
¢ Explore VMware—access the VMware Environment Overview page.
* Add Monitoring—add Hyper-V or VMware agents to your environment.

You can also obtain information about the status of your license for Foglight. This status is indicated by messages
displayed on the tile of the installed products. For more information on licenses, see the Administration and
Configuration Guide.

In addition, the Getting Started provides several video tutorials and the Evaluation Guide which is intended for
anyone who wants to perform a quick evaluation of the power and ease-of-use of Foglight.

To access the Perspective views for any of the installed vFoglight cartridges, open the navigation panel, expand
the Dashboard module, and click Perspective Selector > Perspective.

The Perspective dashboard provides a summary view of the different parts of your environment. Each perspective
summarizes the key information related to a particular area of interest. Each perspective contains a section on the
right side that shows the total number of alarms for each severity. Most perspectives also include a detailed view
that list the number of objects (VMs, Hosts, and so on) within that environment, broken down by the entity’s alarm
status. If a single object has multiple alarms, each alarm is counted. For this reason, the total number of alarms
frequently exceeds the total number of objects with alarms.
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Each perspective contains an Explore button. Click Explore to investigate the full details displayed in the VMware
Environment dashboard.

Changes to the Foglight User Interface

Foglight 6.3.0 introduces an updated user interface that improves navigation and search functions. Some legacy
functions are not available in the new interface components. To access these functions, you must switch to the
previous Foglight interface (refereed to as the Classic Foglight web console). When these functions are described
in the sections below, a note will indicate that this step is necessary.

Refer to Opening the Foglight classic Web Console for more information.

Navigating Foglight

In addition to the links on the Welcome page, use the navigational aids described in the sections below to navigate
Foglight.

NOTE: Foglight displays dynamic data that is updated regularly. For this reason, avoid using your
browser’s navigation buttons, as this may display cached views or result in an error message. Use the
links in the navigation panel and display area instead.

TIP: Visit http://eDocs.quest.com to watch our learning videos. See Introduction to the Foglight User
Interface.

Using the Navigation Panel

Use the left-hand navigation panel to move between dashboards. This panel lists all dashboards that are available
to you based on your roles. Expand a module and select a dashboard to view it in the display area (for example,
Dashboards > Services > Service Levels). The navigation panel can be edited to show only the modules that
interest you. You may search the navigation panel to show only dashboards matching the entered string.

Foglight remembers the state of the navigation panel between logins, so if you make changes to the navigation
panel when you log out, those changes will persist the next time you log in.

Changing to the Classic Foglight web console

Using the Breadcrumb Trail

The name of the current dashboard is displayed in bold at the top of the dashboard, at the end of a path called the
breadcrumb trail.

Figure 1. An example of the breadcrumb trail.
fAgents on &l Hosts = Property Viewer

When you move directly from one dashboard to another, the names of the previous dashboards are displayed in a
breadcrumb ftrail.

Use the links in the breadcrumb trail to return to previously-viewed dashboards in a workflow or series of
drilldowns.
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Using Drilldowns

Use the graphical and text links in views to drill down to additional details that help you diagnose problems.
Depending on the link, you drill down to a different dashboard or a smaller view called a popup that appears above
the dashboard you are currently viewing.

You can drill down from many different parts of a view, including names of monitored components (such as hosts
or services), the Explore links in a popup, and items like charts, tables, cylinders, and icons.

For example, in the My Services dashboard, click the explore & icon will drill down further into the detailed
information of that service.

Using Bookmarks

i | IMPORTANT: Setting bookmarks requires the Action Panel. The Action Panel is not visible in the default
Foglight Ul configuration. To view the Action Panel, you must open the Classic Foglight interface. Refer to
Opening the Foglight classic Web Console

Use bookmarks to keep track of dashboards and views that you want to revisit or access quickly, without having to
drill down several levels. A bookmark can be a snapshot of data that is “frozen” at a specific point in time, or it can
be updated with current data when you access it. For example, you could create a bookmark to quickly access the
System Overview on a particular host from last Wednesday.

You create a bookmark by navigating to the dashboard you want to bookmark, selecting Bookmark from the
action panel, and then selecting options from the Bookmark dialog box. See the online help for the Bookmark
dialog box for details.

Figure 2. The Bookmark dialog box.

Bookmark ®

Hame Alarms
Keep for @ Forever
O days
[]send an email with a link to this bookmark
[ Preserve state

Preserve time range
Description

The bookmarks you create are listed in the Bookmarks section of the navigation panel. When you select a
bookmark, it appears in the display area.
To email a link to a bookmark:

1 In the Bookmarks area of the navigation panel, select a bookmark to display it.

2 Select Email from the action panel. An email window opens, containing a link to the bookmark.

3 Fill in the required information and click Send.

To delete a bookmark in the navigation panel:
1 Place the cursor over the dimmed delete icon beside the name of the bookmark. The icon turns red: &.
2 Click the delete icon.

3 On the confirmation dialog, click Delete to delete the bookmark.
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Opening a New Window

Opening a new window instead of using the current browser is useful, for example, when you want to open a link
or print a document, such as a PDF. When you use a new window, the document downloads or prints in the
background and you are prevented from accidentally closing the browser window when closing the PDF.

To open a new window:

1 Click the New Window link in the action panel to open a new browser window and change the URL to
create a sub-session.

2 Navigate and click on the sub-session tab to reload the new browser window or tab independently of the
source session.

Running a Report

You can run, create, and manage your reports from any dashboard. The Reports menu is available on the top right
corner of a dashboard. Some dashboards have an associated report template displayed at the top of this menu.
For example, open the hosts dashboard. The All Hosts Report template is listed. In addition, if a user has created
reports based on a dashboard and allowed your user role access to it, these reports are also listed in the Reports
menu for that dashboard. For more information on reports, see Reporting on Your Enterprise on page 75.

Figure 3. The Monitored Hosts dashboard with the Report menu selected.

Hosts Only (Simpl i G Thursday, October 15, 2020 2:52:57 PM - Now 60 minutes ~ | [ N

- : : : All Hosts R
Bl Monitored Hosts Only (SimpleGlobalService) e —
The Hosts dashboard provides a high-level summary of host state and performance, including alarms, CPU, memory, disk, and network ufilization. © Crese=a Nen Report
P Run aReport
Filter By Activity: | Monitored Hosts Only (Hosts for which CPU or Memory metrics are collected) V| Eg Manage Reports
SimpleGlobalService ¥ | & &z @ ‘ H Search || Advanced |
@Add Host Search P-| &
Host Alarms CPU Memory Disk Network Monitored Impacted
Type Name « F C W Utilization Current Current /o Usage Current Services
A = o —— 13% %4% o] - =

Choosing a Home Page

IMPORTANT: Setting a home page requires the Action Panel. The Action Panel is not visible in the default
Foglight Ul configuration. To view the Action Panel, you must open the Classic Foglight interface. Refer to
Opening the Foglight classic Web Console.

You can choose any dashboard and make it your personal home page. Other dashboards can also be designated
as home pages by a dashboard developer. These are listed under Homes in the navigation panel.
To set your personal home page:

1 Select any dashboard in the navigation panel on the left. Choose the dashboard that is most appropriate for
your needs.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The
classic web console will open in a new tab.
3 Click Make this my home page in the action panel.

The dashboard is listed under Homes in the navigation panel and will be the first page that Foglight
displays every time you log in.

Foglight 6.3.0 User Guide
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If you later choose another dashboard as your home page, it replaces the previous one.

NOTE: You can have multiple homes. When you mark something as a home page, it becomes the default
home and it is added to the list of possible homes. For example, if you add the My Services dashboard as
your home page, Foglight adds it to the your default set of homes and it becomes your current home. If you
log out and log back in, you will access the My Services dashboard.

Getting Started FAQ

When | log into Foglight, why | do not see any dashboards in the navigation panel?

Foglight controls access to dashboards and views by means of roles. Your Administrator assigns users to groups
and then assigns roles to those groups.

If you do not see any dashboards in the navigation panel, the user you signed in as may not have been assigned
to a group. Contact your Administrator for assistance.
What determines which dashboards and views | can access?

When you try to access a dashboard or view, Foglight matches the roles of the groups to which you belong against
the relevant roles and the allowed roles that were set for that dashboard or view.

Relevant roles control which dashboards and views are listed in the navigation and action panels. Allowed roles
control which dashboards and views a group can access. In some dashboards, one or more views may not be
available because your roles have not been set as allowed roles for them.

Table 1. The Operator and Advanced Operator roles have the following permissions:

This role: Has these permissions:

Operator Access to basic dashboards. Operators can also access dashboards like My
Services, Agents, and Hosts.

Advanced Operator Extends Operator to include dashboards like the Service Builder.

If | navigate away from a dashboard, do | see the same views when | return?

Yes. If you leave a dashboard and then return to it, you see the last views that were displayed.

Working with Dashboards

This group of topics describes how to work with Foglight dashboards and provides an overview of the common
elements that are found on most dashboards.

Introduction to Views and Dashboards
Foglight uses views to group, format, and display monitoring data.

Dashboards are top-level views that do not need to receive data from other views. Dashboards typically contain a
number of other views that display monitoring data. You access dashboards using the navigation panel.

Foglight includes a number of monitoring views and dashboards. You can also create and edit your own custom
views and dashboards.

For information about common elements that are found on most dashboards, as well as creating your own custom
views and dashboards, see the following topics:

e State Indicators

e Severity Indicators

Foglight 6.3.0 User Guide 12
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* Availability Indicators

¢ Tooltips, Dwells, and Popups

¢ Drop-Down Lists and Trees

e Customizer

* Exporting Data from Charts and Tables
e Common Views

» Switching to Console Mode

* Creating a Custom Dashboard

e Customizing Dashboards

¢ Working with Charts

Screen Elements

This section describes the Foglight screen elements that you can see regardless of which cartridges have been
installed.

In addition to the display area and the two panels, a typical screen in Foglight includes other elements, which are
indicated in the following graphic.

Figure 4. Elements in a typical screen.
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For more information, see the following topics:
* Navigation Panel
* Display Area
* Action Panel

e Zonar and Time Range
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¢ Close Arrows
e Header
e Search

* Reports Menu

Navigation Panel

The navigation panel contains all the dashboards that you can access based on your role. On the left side of the
page, hover your mouse over the arrow to view the list of available dashboards. Expand a module and select a
dashboard to view it in the display area. The navigation panel can be edited to show only the modules that interest
you. You may search the navigation panel to show only dashboards matching the entered string.

When you move your mouse away, the navigation panel closes to give you a full view of the dashboard contents. If
you want to keep the navigation panel open, click the arrow on the left of the display area. To close the panel, click
the arrow again. See Close Arrows.

Foglight remembers the state of the navigation panel between logins, so if you make changes to the navigation
panel when you log out, those changes will persist the next time you log in.

; | NOTE: If you do not see any dashboards in the navigation panel, the user you signed in as may not
have been assigned to a group. For more information, see Getting Started FAQ.

Editing the Navigation Panel

Use the navigation panel’s Edit Mode to show only the dashboards that interest you. Changes made to the
navigation panel will persist after logging out.

To edit the navigation panel:

1 On the Foglight navigation menu, click the Edit Mode icon .

2 Next to each module you want to hide, click the Hide/Show icon .

3 Hidden modules are displayed in a darker gray. To view any hidden modules, click the Hide/Show icon

&
4 When finished, click the check to save.

Navigation Search

The search function in the navigation panel allows you to easily find modules and dashboards containing your
search string.

As you begin typing, the items displayed in the navigation menu will be filtered to match your search. To cancel the

search, click the in the search field.

Opening the Foglight classic Web Console
Some actions require controls not present in the new Foglight interface. To use these functions, you must open the

Classic Foglight web console.
To open the Classic Foglight web console:
1 On the Foglight navigation menu, click the Open Foglight classic web console icon .

The Classic Foglight web console will open in a new tab.
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Action Panel

IMPORTANT: The Action Panel is not visible in the default Foglight Ul configuration. To view the Action
Panel, you must open the Classic Foglight interface. Refer to Opening the Foglight classic Web Console

The action panel lists the various actions that you can perform on the current dashboard. It also lists views and
data that you can add to a dashboard or report that you are creating and provides access to the online help.

On the right side of the page, hover your mouse over the arrow to view the list of the available actions. When you
move your mouse away, the action panel closes to give you a full view of the dashboard contents. If you want to
keep the action panel open, click the arrow on the right of the display area. To close the panel, click the arrow
again. See Close Arrows.

Foglight remembers the state of the action panel between logins, so if you collapsed the action panel when logging
out, the panel is collapsed the next time you log in.

Tabs

The following tabs are available in the action panel:

¢ General tab—contains a number of actions that you can perform on the current dashboard or report, as
well as other actions you can perform (such as opening a new window or creating a new dashboard or
report).

* Design tab—provides access to design the display area, including area definition, layout, and context.
¢ Help tab—provides access to the online help and a search field for the help.
When you are working with a custom dashboard or report template, two more tabs appear:

¢ Views tab—add a view from the list to your report or dashboard by dragging it to the display area. See
Adding a View Using the Drag and Drop Functionality for more information.

» Data tab—display a data object in a view (that Foglight adds to your dashboard) by dragging the object into
the display area. See Adding a View Using the Drag and Drop Functionality for more information.

Close Arrows

The Close arrows are used to conserve space on the display area. Click the arrows to:

expand the display area and collapse the navigation panels.

Header

Figure 5. The Foglight header

Table 2. The header contains the icons described in this table.

Icon Description
The Foglight logo.
Foglight ™
Search Type a search string to see hits in all Monitored Objects. For more information,

]
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Table 2. The header contains the icons described in this table.

Icon Description

Displays your user name. Clicking the icon or the arrow, two sub items will be
displayed, Preferences and Sign out.
* Click Sign out to log out Foglight. When you log out, Foglight reclaims all
resources used in the current session.
NOTE: This is the recommended way to exit Foglight, rather than just closing the
browser.

@' username

Displays the general information for Foglight, including the following sub items:

E Information icon e Help: Click the item to access to the online help and a search field for the

help.

* Quest Support: Click the item to access to the Support Bundles page.

* Send Feedback: Click the item to access to the Contact Us information on
Quest company website.

* About: Click the item to display the version information, copyright
information, as well as Legal Notices and Contact information.

Search

The Search field, located in the header, is a global search tool which allows you to search for any monitored object

i | NOTE: If you have the cartridge developer role, you can also view Web Component Framework (WCF)

search hits listed under the Definitions category.

To complete a global search:

1 Type a search string into the search text box.

Figure 6. A list of results is displayed.

sal
Q

/A FVES5-MysSQL

&L MSSQLIGUNIX

& LiteSpeed for Sql Server
& ApexSQL Test

E,___I mysqlinstancel

E,___I mysqlinstance5

E,___I monsql2016sp2w

2 Select an entry to view the search result.

Clicking an entry opens a dashboard associated with the monitored object. If the object is not associated
with a specific dashboard, a summary view opens to display the metric details for that object.

Reports Menu

You can run, create, and manage your reports from any dashboard. On the top right corner of the dashboard is a
reports menu. Some dashboards have an associated report template displayed in the top of this menu. For more
information on reports, see Reporting on Your Enterprise on page 75.
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Display Area

The display area is where you view dashboards or reports and work with elements in your custom dashboards and
reports. See Creating a Custom Dashboard and Building a Custom Report Template for more information.

i | TIP: Maximize the size of the display area by closing the navigation panel.

Zonar and Time Range

Foglight controls the current time range using a special control called a zonar. See Time Range for more
information. The default time range is the last 4 hours.

Time Range Freeze Control

You can freeze the data Foglight displays at a specific time range to diagnose problems that occurred during that
interval. See Freezing a Time Range for more information.

Time Range

The time range at the top of a dashboard indicates the current time range for all the views on the page. You can
override the default current time range setting (the last 4 hours), by choosing another interval in the User
Preferences page. For more information, see Setting Your User Preferences.

i | NOTE: If some of the views contained in a dashboard have independent time ranges, Foglight does not

display the time range.

By default, the time range in a dashboard is displayed in real time. You can freeze the time range so that the data
Foglight displays in the views reflects a certain interval. When the time range is frozen, the views do not display
new data. Freezing the time range helps you diagnose problems that occurred during a specific interval. For
further details, see Freezing a Time Range.

Changing the time range in a dashboard normally affects all the views in the dashboard. If an individual view in a
dashboard has a different time range, that takes precedence over the time range for the dashboard.

Click the time range (shown below) to access the timeline and calendar options, which allow you to specify a new
time range.

Figure 7. Time range.

G Friday, June 12, 2009 9:32 AM - Mow 4 hours

; | NOTE: The time range for a summary view is likely to be different from the time range for a detail view.
Therefore, the time range that you select affects only the current view and drill-downs from it; it does not
affect higher-level views.

Timeline
Click the Timeline option in the time range to:
* Select a pre-defined time range interval, from the last hour to ‘all time’.

* Specify a custom time range using a sliding bar called the zonar.

Figure 8. The sliding bar called the zonar.

Alarms. = Friday, June 12, 2009 9:27 AM - Mowe o howrs
Timeline | Calendar Lsst dh 4h th 24h dsh 72h 7 All Morew

6/12]091:27:16 AM 6/12]09 1:27:16 P

Hover the cursor over the zonar to cause a popup to appear that displays the dates and interval (hnumber of hours
or days) spanned by the time range.
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Figure 9. Popup displaying the dates and interval spanned.

Friday, June 12, 2009
Alarms. 9142 AM - Now 2009 9:42 AM - Now 4 hours.
dhours Joan awh s2h 74 Al e

Timeline | Calendar

6/12/09 1:42:20 AW 6/12/09 1:42:20 PM

Using the zonar

Click the middle of the zonar to drag it to the left or the right. The start and end times of the range changes, but the
total interval it spans stays the same.

Increase or decrease the interval by clicking and dragging one side of the zonar. As you drag, the popup displays
the new time range.

As you drag the edges of the zonar, the timeline scale adjusts automatically, increasing or decreasing the units of
time.

If you drag the right edge of the zonar when the time range is in real time (the word Now is shown in the time range
display), the interval persists and not the specific date and time to which you set the zonar.

Calendar
Use the calendar options to set a specific time range by specifying the time and date from which and to which you
want the range to span.
To adjust the time range using the calendar options:
1 On the left side of the time range, click Calendar.

2 Use the From and To fields to set the time range:

a Click the calendar icon (=) in the From field to set the starting point for the time range.
Alternatively, select Earliest available.

b If you clicked the calendar icon: in the calendar popup, select a date and specify a time. Click
above the field to close the popup.

¢ Click the calendar icon (=) in the To field to set the end point for the time range. Alternatively,
select Current time.

d If you clicked the calendar icon: in the calendar popup, select a date and specify a time. Click
above the field to close the popup.

3 Set the Granularity. See About granularity for more information.

4 Click Apply to update the views based on the new time range.

; | NOTE: If you enter an invalid date or time, a red exclamation mark appears and you
cannot apply your changes.

About granularity

Granularity controls the size of the metric intervals. The default option is Raw, which displays the actual collected
data points. The Auto option uses intervals that are sized according to the time range. For example, a one-hour
range has five-minute intervals, while a one-week range has one-hour intervals. Ranges from 1 minute to 1 week
are also available.

If you set too large an interval, there may not be enough points to plot on a chart. For example, if you only have
one day of data, an interval of six months results in a single point. If an interval is too small, there may be too many
data points to display if the chart is small.

The maximum and minimum values of a metric are actual numbers, while data points inside an interval are
averaged. Agents may report their data at uneven intervals. Foglight sets the data to be plotted in evenly-spaced
intervals using data collected from any number of agents.

To do this, the data points inside the interval are averaged. This has the effect of evening out the maximum and
minimum values if an interval contains more than one real data point. The maximum and minimum values of a
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metric are based on real data and not an averaged value. These values are often plotted as markers on the chart.
Therefore the averaged values on the plotted curve or bar may not match the real values of the markers.
To select a granularity value:

1 In the Calendar, select an option from the Granularity menu on the right side of the interface.

2 Click Apply.

Freezing a Time Range

By default, the time range on a dashboard is displayed in real time. You can tell this at-a-glance if the word Now is
shown in the time range display.

Figure 10. The word Now indicates that the time range is displayed in real time.

E Wednesday, May 14, 2008 602 AM - Maw 4.0 hours -

You can disconnect from real time and “freeze” a dashboard at a specified time range. When this occurs, the views
on the dashboard will not receive any new data.

Some views show a frozen time range by default. This type of time range is called a diagnostic time range. See
Diagnostic Time Range for more information.
To freeze a time range:

1 Select the dashboard for which you want to freeze the time range.

2 Click the = icon to the left of the displayed time range at the top right of the dashboard.
; | TIP: When you hover over the icon a popup indicates if the time range is real time or frozen:

The time range is set and the icon changes to [t4].
Hover over the icon to display the message: Time range is in the past, click to switch to real time.

3 If you later refresh a dashboard, you may notice that the time range remains fixed even though the time
that is displayed in the zonar changes.

Figure 11. For example, the time range ends at 10:01, but the current time is later.

4] Wednesday, June 17, 2009 601 AM - 10:01 AM 4 hours

To unfreeze a time range:

¢ Click the |t4] icon.

The time range changes to end at the last monitoring time range that you used (for example, the last four
hours).

Diagnostic Time Range

In some places in the Foglight browser interface, a diagnostic time range is calculated when drilling down on an
item of interest. This most often happens when looking at the details of an alarm. By default, Foglight shows a four
hour window, where the alarm time range is placed three hours into the window (that is, three hours prior and one
hour past the alarm). The diagnostic time range stays frozen until you unfreeze (toggle) the time range.

The diagnostic time range function works as follows:

* Forany alarm that is not in the current time range, clicking on a drill down places you into a diagnostic time
range.
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* Some drilldowns indicate that you are in diagnostic time range as shown in the dialog box below.
Figure 12. The drilldown indicates that you are in diagnostic time range.
[(4] Diagnastic time ranae Thursday, May 6, 2010 3:09 PM - 7:09 PM 4 hours

hostl exsmpie. com (Hosti(Host)
| Health: & Alarms:

& U 1w
& Memary — 59 %
& Disk _ 3w
& Metwark 0%

Related
Host Monitar
Host Browser
Host Infarmation

i | NOTE: The diagnostic time range function is not available for all drill-downs.

State Indicators

There are several different types of alert indicators used to represent monitoring data in Foglight. The types are:
e Severity Indicators
e Availability Indicators

The severity and state icons tell you about the condition of an application, server, or process. What they represent
changes according to their context. They often represent a rolled-up state of the data collected on the object. For
example, the same state icon can indicate that a server is down or that a process is down.

Many summary views show icons that represent an aggregation of the detailed objects of similar types. You can
have Foglight prioritize the data when determining the aggregation by creating a service level agreement to do
this. For example, if three test servers are down, and one production server is active, then a summary view would
show a critical icon, not a fatal icon.

Depending on where it is, you can hover over a severity or state icon or click it to get further information about the
condition it represents.

Severity Indicators

Severity indicators can indicate:
» the severity level of alarms that have fired.

» the status of an object. For example, a domain, server, application, or process.

Table 3. Severity indicators:

Se\{erlty Indicates... Description
Indicator
a Normal The component is operating within normal thresholds.
A normal severity level indicates that there have been no critical, warning, or fatal
events fired. Foglight does not record events that are successful; it can only determine
that there are no events that had problems.
i Warning Represents a possible performance problem, based on calculations on current server
= metrics against best-practices thresholds.
@ Critical Indicates that the current metric values point strongly towards performance-related
problems with the specified component.
o Fatal There is a very strong indication that the server is experiencing conditions which will

degrade performance.
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Availability Indicators

Availability indicators show the availability of a service.

Table 4. Availability indicators.

lcon Description

5;; Available

3 Not available

Tooltips, Dwells, and Popups

Different types of smaller views provide additional detail about an element in a view. Examples of these views are:

* Atooltip element describes what it represents when you hold the cursor over a status icon. A tooltip also
appears when you hover the cursor over a line in a chart (as shown below).

* Adwell displays additional information about the item when you hold your cursor over a line in a table.
* Apopup displays additional information and options if you click a line in a table.

Tooltips and dwells disappear when you move the mouse, but a popup remains open until you close it by clicking
outside it or clicking the close icon * in the corner. You can also maximize some popups by clicking the maximize
icon O in the upper right corner.

Figure 13. Tooltips appear when yo uhover the cursor over a line in the chart.

host3, example. com -3

wﬁu

Memory Page Out Rate (cfs)
44 cfs @ 5/7/10 10:40 AM

0

07:40 08:00 08:20 08:40 09:00 09:20 09:40 10:00 10:20 1040 11:00  11:20

wsshiemory Page Out Rate (cis)
hemory Utilization (%)

Columns

When you are creating a custom dashboard or report, you can choose one of the options under Columns under
the General tab in the action panel to divide the display area into one, two, or three columns.

Figure 14. Column options.

 Caolumns

=1 [EEz] oeoz
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Drop-Down Lists and Trees

Drop down lists are views that change the context of other views, such as those in the same container view. When
you select an item from a drop down list, the view is refreshed with new data. For example, a view may contain a
drop-down list of metrics, a chart, and a table. Selecting a different metric changes the context of the page, and the
chart and table are updated accordingly.

A drop down displays a list of single options. A tree expands to display a hierarchy of options. Both can have the
same effect on the context.

Customizer

Depending on how the chart was designed, the customizer icon := might appear when you hover the cursor over
a chart or might always be visible. For example, on the Alarms dashboard, the customizer for the Alarm(s) table is
always visible.

; | NOTE: Depending on the context, the customizer icon is also called the Edit or Options icon.

If the customizer icon is enabled you can:
» Select which columns you want to appear in a table.
¢ Change the chart type dynamically. See Changing the Chart Type.

¢ Export charts and tables to PDF, CSV, Excel, XML, or Image format. See Exporting Data from Charts and
Tables.

Exporting Data from Charts and Tables

The option to export data to PDF, Excel, CSV, XML, and Image formats are available for charts and tables.
For example, you can create new graphs using drag and drop metrics onto a dashboard, and then export the data
to CSV output. Therefore, you can create multiple metrics, set a time range, export to CSV, and then open the data
in Excel.
To export charts and tables:
1 Navigate to the chart or table you want to export.
Click the Customizer icon :% in the top right-hand corner of the table or chart.
Click Export.
Choose the format to export.

Select a format and click Next.

o o b~ WN

If you have chosen to use the PDF format, you can customize the PDF report by completing any of the
following steps:

a In the Title box, type a title for your report.

b Inthe Notes Before box, type a note to appear after the title of your report.
¢ In the Notes After box, type a note to appear after the exported view.

d Click Yes to include a table summary of the data from the exported view.

e In the View Export dialog box, click Save as Report to save it to My Dashboard in the navigation
panel, or click Export to view it in a separate browser window.

7 Select the metrics to export.
8 Click Export.
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Common Views

Foglight makes use of common views in most of the standard dashboards. Using common views in dashboards is
an effective way to enable and create easy workflows. Examples of views used in many of the dashboards include
the Alarm List and Host Summary.

Alarm List

The Alarm List view displays a summary of alarms. The Alarm list view allows you to examine alarms from different
perspectives by choosing one of the following tabs:

¢ Alarms(s). See Viewing, Acknowledging, and Clearing Alarms.
e Error Instance(s)

¢ Related Host(s)

* Related Agent(s)

Expand nodes in these tabs and click on details to drill down and further investigate aspects of the alarms in your
system.

For additional information the Alarm List view, see the following topics:
¢ Hiding Columns
e Alarm Chaining
» Historical Alarm Occurrences

e Alarm Notes

Error Instance(s)

An error instance is any object in your environment that is the source of an alarm.

Foglight lists each error instance’s health, number of alarms, and health history in the Error Instance(s) tab.

Related Host(s)

You can isolate issues related to systems more easily by showing alarms organized by the originating host.

Foglight lists each host’s health, number of alarms, and health history in the Related Host(s) tab.

Related Agent(s)

You can understand which agents are causing alarms to fire by showing alarms organized by the agent that
collected the data.

Foglight lists each agent’s health, number of alarms, and health history in the Related Agents(s) tab.

Hiding Columns

You can hide any of the columns in the Alarms List view.

To hide columns:

1 Click the edit icon =% above the table.
A popup displays a list of the columns in the table.

2 Clear the check boxes for the columns you want to hide and click Apply.
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The columns are removed from the table.

Alarm Chaining

An alarm chain is a series of consecutive non-normal alarm states for the same alarm event. For example, the
CPU utilization on a specific machine keeps changing values that trigger a non-normal state. The following chain
describes the alarm from 10:55 until 11:30 (when it becomes normal again)

10:55 AM — Normal
11:00 AM — Warning
11:05 AM — Critical
11:15 AM — Fatal
11:20 AM — Warning
11:25 AM — Critical
11:30 AM — Normal

Using the Alarm Details dialog box, you can choose either the Acknowledge or Acknowledge Until Normal option
for a current alarm if you want the alarm to remain acknowledged until it reaches a normal state. For example, if
you choose the Acknowledge until Normal option at 11:00 AM, the alarm stays acknowledged until 11:30 AM. In
contrast, if you choose the Acknowledge option at 11:00 AM, the alarm (chain) would be “Unacknowledged”
again at 11:05 AM when the severity has changed.

i | NOTE: Alarm chains can only be seen in the Alarm Details dialog box. See Viewing Alarm Details for

more information about this dialog box.

Historical Alarm Occurrences

From the Alarm Details dialog box, you can drill down to a view that shows historic occurrences of an alarm. For
example, if you are looking at the CPU utilization alarm for host1, you can go to a view that shows historic
occurrences of that alarm (CPU utilization) on the same object (host1).

To view historical alarm occurrences for an object:

1 On the Alarms dashboard, drill down to an alarm and click the alarm to display the Alarm Details dialog
box.

2 On the Alarm Details dialog box, click Find Historic Occurrences.
Figure 15. The Alarm Historic Occurrences view appears.

% Alamns * Alarm Historic Docurrences 1] Tuesday, June 16, 2009 D514 AM - 10:42:05 AM 50 5 rainutes '

Host nfa Instance (YMWESKServeremar. .
Agent Origin (& Fui) WM ES Server Balloon Memary ..
Agent Type Whware Infrastructure Default Drilldown nfa
This view shows a max of 15 occurrences starting From the beginning of the current time range, Please use << and =3 ko scroll through other occurrences,
<< Get More Mo More Cccurrences ==
2 Histaric Occurrencels) A i
Start Time « Time Cleared Maix Sewverity Tokal Duration Moke(s) =
©  B/16/09 951 AW A16/09 10:14 M & 23 min 0 -
© /1609 10:42 AM @ 52 min u]

This view consists of the following main components:

= Time range menu: provides a quick way to change the current time range. Select an option in this
menu changes the current time range to the selected time period and updates the entire view. If
there is no alarm occurrence in the selected time period, nothing will be shown in the graph and in
the table.
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= Alarm historical occurrences table: lists alarm occurrences in the current time range. The dwell and
popup on each row show the alarm severity transitions of the alarm occurrence in that row. The
Notes column shows the number of notes added to each alarm occurrence. Details of these notes
are available through the dwell and popup.

= Aset of alarm occurrence controls: these controls show “>> No more occurrences” if there are no
occurrences outside of the current time range. If there is a “<< Get more” control on the left, this
indicates alarm occurrences prior to the current time range. Mouse over this control to show the
creation time of the most recent occurrence before the current time range. Click on this control to
display this alarm occurrence into the table and at the same time adjust the current time range to
include this occurrence. The “>> Get more” control works the same way for alarm occurrences after
the current time range.

Alarm Notes

Alarm notes provide you with a handy way to record information about an alarm for all other users to view. For
example, if you are managing alarms during an installation of Foglight and if an urgent alarm comes up, you can
add a note to the alarm that you are checking if the back-up process may be causing the problem. The note, along
with a username stamp and a timestamp, are attached to the alarm.

There are two ways to add notes from the Alarm Details dialog box, by using either the:

* History tab. The Notes k] icon in the Alarm History table is for maintaining notes attached to a particular
alarm in the history table. Clicking the Notes k] icon, takes you to the Alarm Notes dialog box.

* All Notes tab. New notes are automatically attached to the most recent alarm in the alarm history.

Creating an Alarm Note

Alarm notes consist of free-form, non-localizable text, a user name, and a timestamp.

To create an alarm note:
1 From the Alarm Details dialog box you can either:
= In the History tab, click on the Alarm note icon. The Alarm Notes popup appears. Click Add.
= |n the All Notes tab, click New.
2 In the Add Note dialog box, type a description of the note.
3 Click Add.

The description is added to the Alarm Notes dialog box.

Editing an Alarm Note

Only the creator of the note can edit the note.

To edit an alarm note:

1 From the Alarm Details dialog box, you can either:

= Click the History tab, and then click the Notes k! icon. The Alarm Notes dialog box appears.
= From the All Notes tab, go to step 2.

2 Click the Edit b2f icon.
3 In the Edit Note dialog, change the description of the note.
4 Click Submit.

The description of the note changes to the modified text.
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Deleting an Alarm Note

Only the creator of the note can delete the note.

To delete an alarm note:

1 From the Alarm Details dialog box you can either:

= Click the History tab, and then click the Notes k.l icon. The Alarm Notes dialog box appears.
= Click the All Notes tab, go to step 2.

2 In the Alarm Notes dialog box, select the check box of the note(s) you want to delete.
3 Click Delete.

The selected notes are removed.

Host Summary
Click or hover the mouse over the name of a physical host to view a host summary popup or dwell.
Figure 16. Viewing a host summary popup or dwell.
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A diagnostic time range is displayed at the top of the summary. This time range indicates the period during which
the alarm was fired. It is usually in the past and is sometimes different from the time range that appears on a
dashboard. For example, the following alarm occurred on Monday May 11th during a particular time range, while
the date displayed on the dashboard is Tuesday May 12th.
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Figure 17. A diagnostic time range is displayed at the top of the summary.
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Click on items in the popup to drill down to more information about the host, its alarms, and its performance.

Drilling down from the popup retains the time range during which the alarm occurred. To go back to the monitoring
time range you last used, “unfreeze” the range by following the procedures in Freezing a Time Range.

Switching to Console Mode

Switch to console mode if you want to maximize the space available in the Foglight browser interface. For
example, when you want to focus on one dashboard in a small or non-standard display.
To switch to console mode:

1 Navigate to the dashboard on which you want to focus.

; | TIP: Create a custom dashboard to focus on a single view. Add just that view to the dashboard and

then maximize it (Options > Maximize in the top-right corner of the view). See Creating a Custom
Dashboard for more information.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The
classic web console will open in a new tab.

3 Obtain the URL to the dashboard:
a Click General > Actions > Properties > Link to this page in the action panel.
b Copy the URL.

4 Paste the URL into your browser’s address bar.

5 Replace page with noc in the URL. For example:

http.//host1.example.com:8080/console/noc/user:operator.1
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6 Go to the new URL.

Foglight displays the dashboard in console mode. Any dashboards to which you drill down are also
displayed in console mode.

To log out manually, exit console mode by following the instructions below.

To exit console mode:

1

Delete everything after console from the URL. For example, if the URL is
http://host1.example.com:8080/console/noc/user:operator.1, change it to the following:

http://host1.example.com:8080/console/
Go to the new URL.
Log in to Foglight.

Foglight displays your home page in standard mode.

Creating a Custom Dashboard

In addition to using the dashboards that are supplied with Foglight or created by dashboard developers in your
organization, you can create custom dashboards for your specific needs. These dashboards can contain any
combination of tables and charts that you find useful.

As with creating a custom report, the custom dashboards that you create are located under My Dashboards in the
navigation panel.

TIP: Visit http://eDocs.quest.com to watch our learning videos. See How to create custom Foglight
dashboards.

To create a dashboard:

1

Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The
classic web console will open in a new tab.
On the action panel, click Create Dashboard.
The Create Dashboard wizard appears.
Choose to base your custom dashboard on one of the following options:

Use All Data—start with a blank dashboard and build it by selecting discrete components from your
database. See Creating a Custom Dashboard Based on All Data.

Start with a service—build a dashboard based on components of the service you select. See Creating a
Custom Dashboard Based on a Service.

Create a Custom Dashboard based on the current dashboard—use the data shown on the current
dashboard to build a custom dashboard. See Creating a Custom Dashboard Based on the Current
Dashboard.

NOTE: This option is disabled if no dashboard is currently selected. To choose the
dashboard to be used as your starting point, select the name of that dashboard in the
navigation panel.

TIP: You can create a custom dashboard or report using parameterized input values. By using
Parameterized Input Values you can quickly redefine what data is displayed in your custom dashboard
or report at any given time. See Using Parameterized Input Values.

When you finish creating your custom dashboard, you do not need to save it. It is automatically available under My
Dashboards in the navigation panel.
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Creating a Custom Dashboard Based on All Data
You can construct a custom dashboard based on all Foglight data by selecting any data available. Foglight
provides you with a blank display area to which you can add any elements you want.

i | IMPORTANT: Creating dashboards requires the Action Panel. The Action Panel is not visible in the default
Foglight Ul configuration. To view the Action Panel, you must open the Classic Foglight interface. Refer to
Opening the Foglight classic Web Console

To create a dashboard based on all data:
1 In the Create Dashboard wizard, Build a Dashboard page, select Use All Data.
2 Click Next.

The View Properties page appears. See Setting View Properties.

Setting View Properties

To set view properties:

1 Inthe Create Dashboard wizard, View Properties page, type a unique name for the dashboard in the Name
field. This is the only information required to create a new dashboard.

2 Select one of the following Auto Refresh Rate options:
= 300 seconds (default rate value)

= Every x second(s)—type the number of seconds in the box to indicate the length of the refresh
interval

=  Never

3 Optional—by default, if you do not select any relevant or allowed roles, the dashboard is available to all
roles.

You can select specific roles to control access to your dashboard. However, the interaction between
relevant roles and allowed roles is complex. Consult your organization’s dashboard designer or your
Administrator for details.

Click the edit icon = beside Relevant Role(s) and/or Allowed Role(s) and select the appropriate roles.

= Relevant Role — Select the roles that allow existing dashboard users to view a dashboard. The
Relevant Role applies to a user who has several roles, such as Dashboard Designer or Foglight
Security Administrator. Selecting the Operator role allows anyone with this role to access the new
dashboard.

= Allowed Role — Determines which user role is allowed to see the dashboard. Leaving the role set
to the default ‘all’ allows all roles to access the new dashboard.
4 Optional — Click the edit icon = beside Background Image and select a background image to use for
your custom dashboard. See Using a Map or Diagram as a Background Image.

5 You can enter a description of the dashboard in the Help text box. This text appears in a tooltip when you
hover over the dashboard name in the navigation panel.

6 Select the Allow this dashboard to be included in other dashboards check box if you want to include
this dashboard in other custom dashboards.

7 Click Next.
The Select Dashboard Layout page appears. See Setting a Dashboard Layout.
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Setting a Dashboard Layout

; | NOTE: You do not need to save your dashboard when you finish making changes. It is automatically

available under My Dashboards in the navigation panel.

To set a dashboard layout:

1 In the Select Dashboard Layout dialog box, select an option to control the size and placement of
information:

= Single-Column Layout—specifies an evenly divided, columnar layout in which the display area is
segmented into one column.

= Two-Column Layout—specifies an evenly divided, columnar layout in which the display area is
segmented into two columns.

= Three-Column Layout—specifies an evenly divided, columnar layout in which the display area is
segmented into three columns.

= Fixed Size—gives you access to the Edit Page Layout option where you can precisely position the
views. For more information, see Editing the Page Layout.

2 Click Finish.

Next, you can customize your dashboard by adding data and view elements to it. See Customizing
Dashboards.

Creating a Custom Dashboard Based on a Service

You can construct a custom dashboard based on a service by selecting any service in Foglight. Foglight provides
you with a blank display area to which you can add any elements you want.

To create a custom dashboard based on a service:

1 In the Create Dashboard wizard, Build a Dashboard page, select Start with a service.
2 Click Next.

Figure 18. The Select a service page appears.

Create Dashboard

Select a service
Return all FSMServices

7| Parameterize this dashboard (what's this)

ev Name Data Type

All Java Systems FSMChildService FSM Chid Service =
Custom Applications FSMCategory FSM Category -
User Host Groups FSMCategory FSM Category -

«Previous | _»Next | Fnsh | Cancel

3 Optional—select the Parameterize this dashboard check box if you want to create a dashboard that is
designed to run with any service.

4 Optional—when Parameterize this dashboard is selected, click the advanced checkbox to choose a

data type for any of the services listed. This enables you to reduce the scope of the report to a particular
data type.
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5

; | TIP: If you later decide to add more views or data elements to your custom dashboard using the drag

and drop functionality, see Using Parameterized Input Values.

From the table, select a service and then click Next.

The View Properties page appears. See Setting View Properties.

Creating a Custom Dashboard Based on the Current
Dashboard

You can create a custom dashboard based on an existing dashboard by selecting any dashboard in Foglight as
your starting point. Foglight provides you with a blank display area to which you can add any elements you want.

To create a custom dashboard based on the current dashboard:

1
2

On the navigation panel, select a dashboard to use as your starting point.

Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The
classic web console will open in a new tab.
On the action panel, click Create Dashboard.

In the Create Dashboard wizard, Build a Dashboard page, click Create a Custom Dashboard based on
the current dashboard.

Click Next.

Figure 19. The Select objects page appears.

Create Dashboard x

Select objects
Select inputs to include those have been selected from the current page you are viewing,

[ Parameterize this dashboard (what's this)
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List of Data Objects

List of Base Types
List of Named Types

«previous | _»Next | _Finsh | _cancel | _Help

Optional—select the Parameterize this dashboard check box if you want to create a dashboard that is
designed to run with any different instances of the specified parameters, which can be passed in from
another view that is drilling into this one.

Optional—when Parameterize this dashboard is selected, click the advanced checkbox to choose a
data type for any of the services listed. This enables you to reduce the scope of the report to a particular
data type.

; | TIP: If you later decide to add more views or data elements to your custom dashboard using the drag
and drop functionality, see Using Parameterized Input Values.

From the table, select an object, and then click Next.

The View Properties page appears. See Setting View Properties.

Foglight 6.3.0 User Guide

Getting Started with Foglight 31



Creating a Report Based on a Custom Dashboard

You can create a report based on a custom dashboard and schedule that report to generate at a specific time. For
example, you have access to a custom dashboard which is monitoring the memory usage for a Host machine that
has been experiencing memory leak problems the past several weeks; you want to send a report to several
interested parties to inform them about the progress of performance for this particular host. To do this, you can
quickly create and schedule a report based on this custom dashboard.

To create a report based on a dashboard:

1

On the navigation panel, under Dashboards > My Dashboards, open the custom dashboard on which you
want to base your report.

Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The

classic web console will open in a new tab.
On the action panel, open the General tab, and click Other Actions > Reports > Createa New Report.

If your custom dashboard does not use parameterized input values, click Convert the current dashboard
into a report and then click Finish.

You can now run the report or schedule the report. See Running a Report or Scheduling a Report.

If your custom dashboard uses parameterized input values, click Create a Report based on the current
dashboard and click Next.

In the Select Options page, choose one of the following options:

= Direct Copy—copy all of the parameterized inputs and report-compatible views from the current
dashboard to the new report. If you have selected this option, click Finish. The report is displayed in
the display area. You can now run or schedule the report. See Running a Report or Scheduling a
Report.

= New report with selected inputs—create a blank report and use a selection of the custom
dashboard’s parameterized input values. If you have selected this option, select which
parameterized input values you want your report to use, and then click Finish. The Add View wizard
appears. See Adding a View and Using Parameterized Input Values.

; | TIP: Watch the tutorial on how to use parameterized input values. From the toolbar in your

report, click Show Tutorial.

Customizing Dashboards

You can add data to your custom dashboard and change the way it is displayed.

For more information, see the following topics:

Adding a View

Editing a View

Adjusting View Options

Working with Charts

Adding Text

Editing the Page Layout

Using a Map or Diagram as a Background Image
Editing Properties

Deleting a Custom Dashboard
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Adding a View

The Add View wizard is provided for the same function as creating a custom report.

To add views using the Add View wizard:
1 If the dashboard is not already opened, select the dashboard from the My Dashboards node.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The

classic web console will open in a new tab.
3 On the Action panel, open the General tab, and click Add view.
The Add View wizard appears.

4 Follow the instructions in Adding a View.

Adding Text

You can use the Add Text option, found on the General tab of the Action panel, to add text to your fixed position
layout custom dashboard. The Add Text option allows you to set a font style for your text, specify a background
image for the portlet view, and to configure an action for the portlet view. For example, you can configure the action
to display a popup view when the user clicks on the text.

Figure 20. A text field with a background image specified.
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To add text to a fixed position layout dashboard:

1 If the dashboard is not already opened, select the dashboard from the My Dashboards node on the
navigation panel.

2 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The

classic web console will open in a new tab.
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On the Action panel, click the General tab, and then click Add text.
The Entering User Text dialog box appears.
Choose to:
= Change the text Style (for example, Heading 1)
= Type the Text to appear on the dashboard.
= Add a Background Image.
For more information, see Using a Map or Diagram as a Background Image.
Click OK.

Next, position the text on your dashboard.

a Click the customizericon ~™ on the top right corner of the portlet view and then click Edit Layout.

b Click the text view header and drag the portlet view to the position you want the text to appear on
your custom dashboard.

¢ Click Done.

Optional—configure the portlet view to complete an action. For example, specify the action to be a popup
view, of the outstanding alarms associated with a view in your custom dashboard, when the user clicks on
the text.

a Click the customizer icon “~ on the top right corner of the portlet view and then click Edit
Properties.

The Config Portlet dialog box appears.

b Click the Action tab, select the check box for the text, and then click the edit icon lif .
The Configure Flow Action wizard appears.

¢ Follow the wizard instructions. For more information, see To configure actions:

Using a Map or Diagram as a Background Image

In conjunction with the fixed position layout custom dashboard, you can set the background to a geographical map
or diagram and then precisely position views on top of it to represent the monitored state of objects at specific
locations.

Use the Edit View Properties dialog box to upload a background image, such as map of a support or sales region
or a diagram of your server rack.

TIP: Quickly add a map as your background image by selecting one of the map images that are
included with Foglight from Dashboard Development > Support > Maps > Base Theme.

To customize your dashboard to represent physical locations:

1
2

On the navigation panel, under Dashboards, open the fixed position layout custom dashboard.

Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The

classic web console will open in a new tab.
Select General > Actions > Properties > Edit basic properties from the action panel.

The Edit View Properties dialog box appears.

Click the Background Image icon ( :3).
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The Select an Image dialog box appears.

5 Enter the URL for the image or navigate to the image in the tree provided or click Upload image to specify
your own image to use a background. If you have specified your own image, a My Definitions directory for
your user account is added to the tree. Each additional uploaded image is added to this directory.

6 Preview the image and click OK.

7 Place monitoring views at specific locations by dragging data or views onto your image. For more
information, see Adding a View Using the Drag and Drop Functionality.

Editing the Page Layout

If you chose the Fixed Size layout option in the Setting a Dashboard Layout dialog box, use the Edit page layout
dialog box to position your view exactly where you want it.

You can also resize the view to fit the space you have available on the screen or change the view’s display options.

To edit the layout of your dashboard:

1 Open the Foglight classic web console to view the action panel.

a On the Foglight navigation menu, click the Open Foglight classic web console icon . The

classic web console will open in a new tab.

2 Select General > Actions > Edit page layout from the action panel.

Foglight displays the views within dashed line borders to indicate that they are selectable.

3 Click a view to cause the edit mode popup to appear.

4 Configure one or more of the following options:

Size and Position—resize or change the co-ordinates of the view.

Grouping—multi-select and group views that you have dragged onto the dashboard. For example,
drag and drop a metric view and a property view related to one of our hosts onto your dashboard,

select both, and click Group ( [ ) to group them together. You can then work with them as one
view.

i | NOTE: When you group views, Foglight nests them as static views. This
means that they do not change when the views from which they were
copied change and Foglight does not update the data they display.

Ungroup the view (for example, to remove one view from the group) by clicking Ungroup ( 1 ) in the
edit mode popup.

; | NOTE: You cannot edit the properties of grouped views.

Order—change the stacking order (bring the view to the front, back, forward, or backward).

Display options—select different options depending on whether you want to show the view title,
show its border, or make it opaque.

TIP: Clear the Show Title check box when grouping views so that the new
grouped view does not display multiple titles.

5 Click Done at the top of the dashboard.
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Editing a View

You can configure your settings for your custom views. For example, you can edit metric views by changing the
display type, selecting metric labels, configuring chart settings, and choosing the action that occurs when you
select or dwell over a metric.

To edit a view:

1 Navigate to the custom dashboard that contains the metric view you want to edit.

2 If your dashboard uses a column-based layout:

a

b

Click the Options icon (:3) at the top-right corner of the view.
Select Edit properties.
The Config Portlet dialog box appears.

If your dashboard uses a fixed position layout:

a

Open the Foglight classic web console to view the action panel.

On the Foglight navigation menu, click the Open Foglight classic web console icon . The
classic web console will open in a new tab.

Select General > Actions > Edit page layout from the action panel.

The views appear in dashed line borders indicating they are selectable.

Click the particular view you want to edit.

A dialog box appears.

Click the Edit [ icon.
The Config Portlet dialog box appears.

3 Make changes to your view. The options and tabs that are available in the Config Portlet dialog box vary
depending on the type of view you are editing. For all view types, you can change the view title.

If an Options tab appears, the options that it lists vary depending on the type of view you have chosen.
Note that certain views and display types do not have options associated with them. If there are options
available, you can save your settings. The next time you create or edit a view, Foglight uses these settings
for that particular view or display type as the default options for your user account.

If you are editing a table view: you can adjust the columns, filter the data you selected based on rules,
and configure actions. See Step 1 in Adding a Table View, Filtering a List, and Actions tab.

If you are editing a property view: you can make changes to the property list or renderer and configure
actions. See Step 8 and Step 9 in Adding a Property View and Actions tab.

If you are editing a metric view: you can make changes to the following:

Title—rename the view.

Height—set the height for all views or this view by selecting the check box and specifying a value.
Display type—select the visual display. For more information, see Display type tab.
Metrics—choose the metric labels for the chart. For more information, see Metrics tab.
Options—configure settings according to the display type. For more information, see Options tab.

Actions—set what happens when a user interacts with the view. For more information, see Actions
tab.

NOTE: The options that are available on the Config Portlet view depend on the type of
view you are editing. The options listed in step 3 are only an example.

4 Click Apply when you are finished editing your view.
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Display type tab

The Display type tab contains options where you can select the visual layout according to a chart type, gauge type,
or list type. For more information on the display types available and their settings, see Options tab.

Metrics tab

Use the check boxes in the Metrics tab to select the metrics that you want to appear in your view.

Options tab

The following tables lists the options available depending on the display type:
e Charts
* Gauge
e List

Table 5. Charts Table:

Icon Name Setti